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This manual explains the functions and operations of GateMX/MW.  To ensure correct 
use, please read this manual thoroughly before beginning operation.  After reading the 
manual, keep it in a convenient location for quick reference whenever a question arises 
during operation.
GateMX/MW is a software program that monitors measured data from the MX100/
MW100 Data Acquisition Unit and supplies the data to DAQLOGGER or remote monitors.

Notes
•	 The contents of this manual are subject to change without prior notice as a result of 

continuing improvements to the instrument’s performance and functions.
•	 Every effort has been made in the preparation of this manual to ensure the accuracy 

of its contents.  However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA dealer.

•	 Copying or reproducing all or any part of the contents of this manual without the 
permission of Yokogawa Electric Corporation is strictly prohibited.

•	 Use of this software on more than one computer at the same time is prohibited.  Use 
by more than one user is also prohibited.

•	 Transfer or lending of this software to any third party is prohibited.
•	 Yokogawa Electric Corporation provides no guarantees other than for physical 

deficiencies found on the original disk upon opening the product package.
•	 License numbers will not be reissued.  Please keep the license number in a safe 

place.

Trademarks
•	 DAQWORX, DAQLOGGER, and DAQEXPLORER are registered trademarks or 

trademarks of Yokogawa Electric Corporation.
•	 Microsoft, Windows, and Windows Vista are registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries.
•	 Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems 

Incorporated.
•	 Company and product names that appear in this manual are registered trademarks or 

trademarks of their respective holders.
•	 The company and product names used in this manual are not accompanied by the 

registered trademark or trademark symbols (® and ™).

Revisions
•	 1st Edition		 December 2003
•	 2nd Edition		 February 2005
•	 3rd Edition		 March 2006 (Cover title changed)
•	 4th Edition		 June 2007
•	 5th Edition		 March 2008
•	 6th Edition		 January 2009
•	 7th Edition		 January 2011
•	 8th Edition		 October 2011
•	 9th Edition		 June 2014
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Software License Agreement

IMPORTANT - PLEASE READ CAREFULLY BEFORE INSTALLING OR USING:
THANK YOU VERY MUCH FOR SELECTING SOFTWARE OF YOKOGAWA ELECTRIC CORPORATION ("YOKOGAWA"). BY INSTALLING OR OTHERWISE USING THE 
SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT INSTALL NOR USE 
THE SOFTWARE PRODUCT AND PROMPTLY RETURN IT TO THE PLACE OF PURCHASE FOR A REFUND, IF APPLICABLE. 

Software License Agreement
1. Scope
This Agreement applies to the following software products and associated documentation of Yokogawa (collectively, "Software Product"). Unless otherwise provided by 
Yokogawa, this Agreement applies to the updates and upgrades of the Software Product which may be provided by Yokogawa.
Software Product:  DAQWORX (It is limited to each software that you bought).

2. Grant of License
2.1 Subject to the terms and conditions of this Agreement, Yokogawa hereby grants to you a non-exclusive and non-transferable right to use the Software Product on a 

single or, the following specified number of, computer(s) and solely for your internal operation use, in consideration of full payment by you to Yokogawa of the license fee 
separately agreed upon.

	 Granted number of License:  1 (one)
2.2 Unless otherwise agreed or provided by Yokogawa in writing, the following acts are prohibited:
	 a)	 to reproduce the Software Product, except for one archival copy for backup purpose, which shall be maintained with due care subject to this Agreement;
	 b)	 �to sell, lease, distribute, transfer, pledge, sublicense, make available via the network or otherwise convey the Software Product or the license granted herein to any 

other person or entity;
	 c)	 to use the Software Product on any unauthorized computer via the network;
	 d)	 �to cause, permit or attempt to dump, disassemble, decompile, reverse-engineer, or otherwise translate or reproduce the Software Product into source code or other 

human readable format, or to revise or translate the Software Product into other language and change it to other formats than that in which Yokogawa provided;
	 e)	 to cause, permit or attempt to remove any copy protection used or provided in the Software Product; or
	 f)	 to remove any copyright notice, trademark notice, logo or other proprietary notices or identification shown in the Software Product.
2.3 Any and all technology, algorithms, know-how and process contained in the Software Product are the property or trade secret of Yokogawa or licensors to Yokogawa. 

Ownership of and all the rights in the Software Product shall be retained by Yokogawa or the licensors and none of the rights will be transferred to you hereunder. 
2.4 You agree to maintain the aforementioned property and trade secret of Yokogawa or licensors and key codes in strict confidence, not to disclose it to any party other 

than your employees, officers, directors or similar staff who have a legitimate need to know to use the Software Product and agreed in writing to abide by the obligations 
hereunder.

2.5 Upon expiration or termination of this Agreement, the Software Product and its copies, including extracts, shall be returned to Yokogawa and any copies retained in your 
computer or media shall be deleted irretrievably. If you dispose of media in which the Software Product or its copy is stored, the contents shall be irretrievably deleted.

2.6 The Software Product may contain software which Yokogawa is granted a right to sublicense or distribute by third party suppliers, including affiliates of Yokogawa ("Third 
Party Software"). If suppliers of the Third Party Software ("Supplier") provide special terms and conditions for the Third Party Software which differ from this Agreement, 
the special terms and conditions separately provided by Yokogawa shall prevail over this Agreement. Some software may be licensed to you directly by Supplier. 

2.7 The Software Product may contain open source software ("OSS"), for which the special terms and conditions separately provided by Yokogawa shall take precedence 
over this Agreement.

3. Restrictions on Application
3.1 Unless otherwise agreed in writing between you and Yokogawa, the Software Product is not intended, designed, produced or licensed for use in relation to aircraft 

operation or control, ship navigation or marine equipment control, or ground facility or device for support of the aforesaid operation or control, or for use in relation to rail 
facility, nuclear related facility, radiation-related equipment, or medical equipment or facility, or under any other circumstances which may require high safety standards.

3.2 If the Software Product is used for the abovementioned purposes, neither Yokogawa nor Supplier assumes liability for any claim or damage arising from the said use 
and you shall indemnify and hold Yokogawa, Supplier, their affiliates, subcontractors, officers, directors, employees and agents harmless from any liability or damage 
whatsoever, including any court costs and attorney's fees, arising out of or related to the said use.

4. Limited Warranty
4.1 The Software Product shall be provided to you on an "as is" basis at the time of delivery and except for physical damage to the recording medium containing the Software 

Product, Yokogawa and Supplier shall disclaim all of the warranties whatsoever, express or implied, and all liabilities therefrom.  If any physical defect is found on the 
recording medium not later than twelve (12) months from delivery, Yokogawa shall replace such defective medium free of charge, provided that the defective medium 
shall be returned to the service office designated by Yokogawa at your expense within the said twelve (12) months.  THIS LIMITED WARRANTY PROVIDED IN THIS 
CLAUSE IS IN LIEU OF ALL OTHER WARRANTIES OF ANY KIND WHATSOEVER AND YOKOGAWA HEREBY DISCLAIMS ALL OTHER WARRANTIES RELATING 
TO THE SOFTWARE PRODUCT, WHETHER EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR ANY PARTICULAR PURPOSE, NON-INFRINGEMENT, QUALITY, FUNCTIONALITY, APPROPRIATENESS, ACCURACY, RELIABILITY AND RECENCY.  
IN NO EVENT SHALL YOKOGAWA WARRANT THAT THERE IS NO INCONSISTENCY OR INTERFERENCE BETWEEN THE SOFTWARE PRODUCT AND OTHER 
SOFTWARE NOR SHALL BE LIABLE THEREFOR. The warranty provisions of the applicable law are expressly excluded to the extent permitted.

4.2 At the sole discretion of Yokogawa, Yokogawa may upgrade the Software Product to the new version number ("Upgrade") and make it available to you at your expense 
or free of charge as Yokogawa deems fit.  In no event shall Yokogawa be obliged to upgrade the Software Product or make the Upgrade available to you.

4.3 Certain maintenance service may be available for some types of Software Product at Yokogawa's current list price. Scope and terms and conditions of the maintenance 
service shall be subject to those separately provided by Yokogawa. Unless otherwise provided in Yokogawa catalogues or General Specifications, maintenance services 
will be available only for the latest version and the immediately preceding version. In no event will service for the immediately preceding version be available for more than 
5 years after the latest version has been released. In addition, no service will be provided by Yokogawa for the Software Product which has been discontinued for more 
than 5 years. Notwithstanding the foregoing, maintenance service may not be available for non-standard Software Product. Further, in no event shall Yokogawa provide 
any service for the Software Product which has been modified or changed by any person other than Yokogawa.
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5. Infringement
5.1 If you are warned or receive a claim by a third party that the Software Product in its original form infringes any third party's patent (which is issued at the time of delivery 

of the Software Product), trade mark, copyright or other intellectual property rights ("Claim"), you shall promptly notify Yokogawa thereof in writing.
5.2 If the infringement is attributable to Yokogawa, Yokogawa will defend you from the Claim at Yokogawa's expense and indemnify you from the damages finally granted by 

the court or otherwise agreed by Yokogawa out of court. The foregoing obligation and indemnity of Yokogawa shall be subject to that i) you promptly notify Yokogawa of 
the Claim in writing as provided above, ii) you grant to Yokogawa and its designees the full authority to control the defense and settlement of such Claim and iii) you give 
every and all necessary information and assistance to Yokogawa upon Yokogawa's request.

5.3 If Yokogawa believes that a Claim may be made or threatened, Yokogawa may, at its option and its expense, either a) procure for you the right to continue using the 
Software Product, b) replace the Software Product with other software product to prevent infringement, c) modify the Software Product, in whole or in part, so that it 
become non-infringing, or d) if Yokogawa believes that a) through c) are not practicable, terminate this Agreement and refund you the paid-up amount of the book value 
of the Software Product as depreciated.

5.4 Notwithstanding the foregoing, Yokogawa shall have no obligation nor liability for, and you shall defend and indemnify Yokogawa and its suppliers from, the Claim, if the 
infringement is arising from a) modification of the Software Product made by a person other than Yokogawa, b) combination of the Software Product with hardware or 
software not furnished by Yokogawa, c) design or instruction provided by or on behalf of you, d) not complying with Yokogawa's suggestion, or e) any other causes not 
attributable to Yokogawa.

5.5 This section states the entire liability of Yokogawa and its suppliers and the sole remedy of you with respect to any claim of infringement of a third party's intellectual 
property rights. Notwithstanding anything to the contrary stated herein, with respect to the claims arising from or related to the Third Party Software or OSS, the special 
terms and conditions separately provided for such Third Party Software or OSS shall prevail.

6. Limitation of Liability
6.1 EXCEPT TO THE EXTENT THAT LIABILITY MAY NOT LAWFULLY BE EXCLUDED IN CONTRACT, YOKOGAWA AND SUPPLIERS SHALL NOT BE LIABLE TO ANY 

PERSON OR LEGAL ENTITY FOR LOSS OR DAMAGE, WHETHER DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES, 
OR OTHER SIMILAR DAMAGES OF ANY KIND, INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OR DESTRUCTION OF DATA, LOSS OF AVAILABILITY AND THE LIKE, ARISING OUT OF THE USE OR INABILITY TO USE OF THE SOFTWARE PRODUCT, 
OR ARISING OUT OF ITS GENERATED APPLICATIONS OR DATA, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER BASED IN 
WARRANTY (EXPRESS OR IMPLIED), CONTRACT, STRICT LIABILITY, TORT (INCLUDING NEGLIGENCE), OR ANY OTHER LEGAL OR EQUITABLE GROUNDS.  
IN NO EVENT YOKOGAWA AND SUPPLIER'S AGGREGATE LIABILITY FOR ANY CAUSE OF ACTION WHATSOEVER (INCLUDING LIABILITY UNDER CLAUSE 
5) SHALL EXCEED THE DEPRECIATED VALUE OF THE LICENSE FEE PAID TO YOKOGAWA FOR THE USE OF THE CONCERNED PART OF THE SOFTWARE 
PRODUCT. If the Software Product delivered by Yokogawa is altered, modified or combined with other software or is otherwise made different from Yokogawa catalogues, 
General Specifications, basic specifications, functional specifications or manuals without Yokogawa's prior written consent, Yokogawa shall be exempted from its 
obligations and liabilities under this Agreement or law.

6.2 Any claim against Yokogawa based on any cause of action under or in relation to this Agreement must be given in writing to Yokogawa within three (3) months after the 
cause of action accrues. 

7. Export Control
You agree not to export or provide to any other countries, whether directly or indirectly, the Software Product, in whole or in part, without prior written consent of Yokogawa. 
If Yokogawa agrees such exportation or provision, you shall comply with the export control and related laws, regulations and orders of Japan, the United States of America, 
and any other applicable countries and obtain export/import permit and take all necessary procedures under your own responsibility and at your own expense. 

8. Audit; Withholding
8.1 Yokogawa shall have the right to access and audit your facilities and any of your records, including data stored on computers, in relation to the use of the Software Product 

as may be reasonably necessary in Yokogawa's opinion to verify that the requirements of this Agreement are being met.
8.2 Even after license being granted under this Agreement, should there be any change in circumstances or environment of use which was not foreseen at the time of delivery 

and, in Yokogawa's reasonable opinion, is not appropriate for using the Software Product, or if Yokogawa otherwise reasonably believes it is too inappropriate for you to 
continue using the Software Product, Yokogawa may suspend or withhold the license provided hereunder.

9. Assignment
If you transfer or assign the Software Product to a third party, you shall expressly present this Agreement to the assignee to ensure that the assignee comply with this 
Agreement, transfer all copies and whole part of the Software Product to the assignee and shall delete any and all copy of the Software Product in your possession 
irretrievably. This Agreement shall inure to the benefit of and shall be binding on the assignees and successors of the parties.

10. Termination
Yokogawa shall have the right to terminate this Agreement with immediate effect upon notice to you, if you breach any of the terms and conditions hereof. Upon termination of 
this Agreement, you shall promptly cease using the Software Product and, in accordance with sub-clause 2.5, return or irretrievably delete all copies of the Software Product, 
certifying the same in writing. In this case the license fee paid by you for the Software Product shall not be refunded. Clauses 2.4 and 2.5, 3, 5, 6 and 11 shall survive any 
termination of this Agreement.

11. Governing Law; Disputes
This Agreement shall be governed by and construed in accordance with the laws of Japan. 
 Any dispute, controversies, or differences which may arise between the parties hereto, out of, in relation to or in connection with this Agreement ("Dispute") shall be resolved 
amicably through negotiation between the parties based on mutual trust. Should the parties fail to settle the Dispute within ninety (90) days after the notice is given from either 
party to the other, the Dispute shall be addressed in the following manner:
	 (i)	 If you are a Japanese individual or entity, the Dispute shall be brought exclusively in the Tokyo District Court (The Main Court) in Japan.
	 (ii)	 �If you are not a Japanese individual or entity, the Dispute shall be finally settled by arbitration in Tokyo, Japan in accordance with the Commercial Arbitration Rules 

of the Japan Commercial Arbitration Association. All proceedings in arbitration shall be conducted in the English language, unless otherwise agreed. The award of 
arbitration shall be final and binding upon both parties, however, each party may make an application to any court having jurisdiction for judgment to be entered on 
the award and/or for enforcement of the award.

12. Miscellaneous
12.1 This Agreement supersedes all prior oral and written understandings, representations and discussions between the parties concerning the subject matter hereof to the 

extent such understandings, representations and discussions should be discrepant or inconsistent with this Agreement.
12.2 If any part of this Agreement is found void or unenforceable, it shall not affect the validity of the balance of the Agreement, which shall remain valid and enforceable 

according to its terms and conditions. The parties hereby agree to attempt to substitute for such invalid or unenforceable provision a valid or enforceable provision that 
achieves to the greatest extent possible the economic, legal and commercial objectives of the invalid or unenforceable provision.

12.3 Failure by either party to insist on performance of this Agreement or to exercise a right when entitled does not prevent such party from doing so at a later time, either in 
relation to that default or any subsequent one.

End of document

Software License Agreement
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How to Use This Manual

Structure of This Manual
This user’s manual consists of the following sections.

Chapter Title Description
1 Overview Gives an overview of the GateMX/MW functions. 

Describes the PC system requirements and system 
configuration that are required to use GateMX/MW.

2 Operating Procedure Describes the operating procedures of GateMX/MW.
3 Error Messages and 

Corrective Actions
Describes the error messages and their corrective 
actions.

Index An alphabetical index of the manual’s contents.

Scope of the Manual
This manual does not explain the basic operations of your PC's operating system (OS).
For information regarding the basic operations of Windows, see the user’s guide that 
came with Windows.

Conventions Used in This Manual
•	 Unit
	 K 	 Denotes 1024.	 Example: 10 KB
	 M 	 Denotes 1024 K.	Example: 10 MB
	 G 	 Denotes 1024 M.	Example: 2 GB

•	 Bold Characters
	 Bold characters are used for characters displayed on the software program screen.

•	 Subheadings
	 On pages that describe the operating procedure in Chapter 2, the following symbols 

are used to distinguish the procedure from their explanations.

			 

Procedure This subsection contains the operating procedure used to carry out
the function described in the current section. All procedures are
written with inexperienced users in mind; experienced users may
not need to carry out all the steps.

			   Note Calls attention to information that is important for proper operation 
of the instrument.
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Chapter 1	 Overview

1.1 Functional Overview of the GateMX/MW

GateMX/MW is a software program that monitors data from the MX100/MW100 Data 
Acquisition Unit (MX100/MW100) and supplies the data to DAQLOGGER or remote 
monitors (software programs).  GateMX/MW enables you to monitor and logging the data 
that can be measured by the MX100/MW100 using DAQLOGGER or a remote monitor.

Note
DAQLOGGER is a software application that can connect various recorders (µR, VR, DARWIN, 
DX, MV, and CX models) and a PC for you to scan, record, and monitor the data.
Remote Monitor is a software application that is included in the DAQLOGGER Client Package 
or DAQ32Plus Client Package.  It can be used to monitor the data that has been acquired by the 
recorder or data acquisition software programs. Add-on software includes a variety of programs 
for customized monitors, network remote monitors, data acquisition and saving on a group basis, 
monitoring of measured data and triggered data acquisition, and other functions.

Features
•	 Up to 32 MX100s/MW100s can be connected.
	 The maximum number of connections from client programs (DAQLOGGER and 

remote monitors) is also 32.
•	 The monitor interval matches the measurement interval of the connected MX100.

* However, the fastest interval on DAQLOGGER is 1 second.
•	 The maximum number of data points that can be held per channel is 1800.

Note
•	 GateMX/MW does not contain functions for configuring the MX100/MW100.
	 To configure the MX100, use the MX100 Standard Software that comes standard with the MX100 

or MXLOGGER, a software program sold separately. Enter MW100 settings using the browser.
•	 GateMX/MW does not contain computation functions.
•	 GateMX/MW does not contain service functions that are available on other Gate programs.
•	 If you use the MX100 Standard Software or MXLOGGER, GateMX100 or GateMX/MW are 

displayed under the Software columns.

Procedure
To scan and record data from MX100/MW100 on DAQLOGGER, carry out the procedure 
given below.  If you are monitoring the data on a remote monitor, follow the instructions 
below and start the data monitoring on GateMX/MW.

		

Turn ON the 
MX100/MW100

Start the MX100 Standard 
Software or Browser

Set the MX100/MW100 
measurement conditions, etc.

Close the MX100 Standard 
Software or Browser

Connect to GateMX/MW
from DAQLOGGER

Start data monitoring
on GateMX/MW

Start logging on
DAQLOGGER

Set tags and other items
on DAQLOGGER

Start GateMX/MW

Register target
MX100s/MW100s

Retrieve info about the
 target MX100s/MW100s

Section 2.1

Section 2.2

Section 2.3

Section 2.4

Operations on GateMX/MW

Note
If you are changing the module configuration on the target MX100/MW100, stop the data monitoring 
on GateMX/MW and turn off the MX100/MW100 beforehand.  After changing the module configuration, 
turn ON the MX100/MW100 and reconfigure using the MX100 Standard Software or the browser.
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1.2 System Overview

Software Requirements
Run DAQWORX under any of the following operating systems. 
•	 Windows Vista Home Premium SP2 (excluding the 64-bit editions)
•	 Windows Vista Business SP2 (excluding the 64-bit editions)
•	 Windows 7 Home Premium, SP1 (32-bit and 64-bit editions)
•	 Windows 7 Professional, SP1 (32-bit and 64-bit editions)
•	 Windows 8 (32-bit and 64-bit) (Supports the desktop mode)
•	 Windows 8 Pro (32-bit and 64-bit) (Supports the desktop mode)
The language displayed by the software under different language versions of the OS are 
as follows. 
OS Language Software Language
Japanese Japanese
Other English

Hardware Requirements
The following hardware is required for running GateMX/MW.
•	 PC:	 	 	 	 	 	 �A PC that runs one of the OS above, and that meets the 

following CPU and memory requirements. 
								        When Using Windows Vista
	 	 	 	 	 	 	 	 Pentium 4, 3 GHz or faster Intel x64 or x86 processor; 2 GB or 	

							       more of memory
								        When Using Windows 7 or Windows 8
	 	 	 	 	 	 	 	 32-bit edition: Intel Pentium 4, 3 GHz or faster x64 or x86 	

	 	 	 	 	 	 	 processor; 2 GB or more of memory 
								        64-bit edition: Intel x64 processor that is equivalent to Intel 	

	 	 	 	 	 	 	 Pentium 4, 3 GHz or faster; 2 GB or more of memory
•	 Free disk space: 	 200 MB or more
•	 Communication device: Ethernet port supported by the OS
•	 CD-ROM drive:	 	 The CD-ROM drive is needed to install the software.
•	 Peripheral devices:	 Mouse supported by the OS
•	 Monitor:		 	 	 	 A video card that is recommended for the OS and a display 	

	 	 	 	 	 	 	 that is supported by the OS, has a resolution of 1024×768 or 	
	 	 	 	 	 	 	 higher, and that can show 65,536 colors (16-bit, high color) or 	
							       more.
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1.2  System Overview

System Configuration

		

MX100

MX100

MX100

Connect up
to 32 units

Hub
MX100/MW100 Data
Acquisition Unit

GateMX/MW
PC

DAQLOGGER/
remote monitor

PC

Ethernet

Up to 32
connections

It is recommended that GateMX/MW and DAQLOGGER be run on different PCs to 
distribute the load.

Software Configuration

	

MX100/MW100

DAQLOGGER

Remote monitor

Ethernet

Ethernet

Monitor data
from the 
MX100/MW100

Ethernet

Ethernet

Add-on Software

GateMX/MW

Configure 
the MX100

Ethernet

MX100 Standard 
Software

or
MXLOGGER

Configure 
the MW100

Ethernet

Browser Deliver the data

GateMX/MW monitors data from multiple MX100s/MW100s that are connected. It also 
acts as a monitor server to deliver the data to DAQLOGGER, remote monitors, or Add-on 
Software.
GateMX/MW does not contain functions for configuring the MX100/MW100. To configure 
the MX100, use the MX100 Standard Software that comes standard with the MX100 
or MXLOGGER, a software program sold separately. Enter MW100 settings using the 
browser. In addition, GateMX/MW does not contain computation functions.
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Chapter 2	 Operating Procedure

2.1 Starting and Exiting GateMX/MW

Procedure
Starting GateMX/MW
Choose Programs > YOKOGAWA DAQWORX > GateMXMW > GateMXMW from the 
Windows Start menu.
The window shown below opens.

		

Note
•	 GateMX/MW starts up in the condition that existed immediately before you closed GateMX/

MW the previous time.
•	 If the program is closed while a process or service is running, the license will be considered 

to be “in use.” If the message, “Invalid license number. Please reinstall.” appears when 
restarting the program, it may indicate that the user is attempting to run a Gate program in 
excess of the number of available licenses.

Starting GateMX/MW in Acquisition Start Mode
1.	 From the Windows Start menu, choose Programs > YOKOGAWA DAQWORX 

> GateMX/MW > GateMX/MW, then right-click GateMXMW and select Create 
Shortcut.  

2.	 Right-click the shortcut icon and select Properties.  
3.	 Choose the Shortcut tab, then add /START (space and /START) to the right of the 

path in the Target box and click OK.  

					   

4.	 Choose the shortcut from the Windows Start menu.  The connection status of the 
previous session is restored, and acquisition begins. 

Exiting GateMX/MW
Choose Exit from the File menu or click the “X” button at the right corner of the title bar.
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2.2 Registering MX100s/MW100s

Before carrying out the procedure below, connect the target MX100/MW100 to the 
Ethernet network and turn its power ON.  Configure the MX100 in advance using the 
MX100 Standard Software that comes standard with the MX100 or MXLOGGER, a 
software program sold separately. Enter MW100 settings using the browser.

Procedure
1.	 Click the Search button.

	 MX100s connected to the network are listed under MX100 nearby

				  

Click

Click to sort by the item name

Note
If a user is already connected to an MX100/MW100, the corresponding computer name and 
MX100/MW100 software application name are displayed under the User and Software columns, 
respectively.  You cannot use GateMX/MW to connect to an MX100/MW100 that already has a 
connected user.

2.	 Drag the machine name of the MX100/MW100 you wish to connect from the 
MX100/MW100 nearby list and drop it onto the MX100/MW100 unit list area.

	 When registered, the IP address of the target MX100/MW100 appears in the IP 
Address/Host column in the MX100/MW100 unit list area.
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Note
•	 You can also register MX100s by entering the IP address or host name directly in the IP 

Address/Host column.
•	 As shown in the figure below, you can select multiple numbers in the No. column and click 

the button below the IP Address/Host column to register incrementing IP addresses starting 
from the IP address of the first number in the selected range.  If a host name is displayed for 
the first number in the selected range, the same host name is registered for all the numbers 
in the selected range.

					   

Select

Click

2.2  Registering MX100s/MW100s
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2.3	 Retrieving Information about the Target 
MX100s/MW100s and Setting the Number of 
Channels and the Monitor Interval

Before carrying out the procedure below, register the target MX100s in advance 
according to the instructions given in section 2.2, “Registering MX100s/MW100s.”

Procedure
1.	 Click the Get Info. button in the Info column in the MX100/MW100 unit list area.

	 When the retrieval of the information is complete, the MX100/MW100 machine 
name appears in the Machine Name column.

					   

Click

Note
•	 If the MX100/MW100 from which you are attempting to retrieve information is already 

connected by another user or if the MX100/MW100 does not exist on the network, the 
information cannot be retrieved. The number of the channel is displayed as 0 and the 
system, hardware, and machine name do not appear.

•	 As shown in the figure below, you can select multiple numbers in the No. column and click 
the button below the Info. column to retrieve information of multiple registered units.

					   

2. Click

1. Select

•	 The information is retrieved again from the registered MX100/MW100 when data monitoring 
is started.

2.	 To change the number of channels after information is retrieved, click in the Num. 
of Ch. column and enter the number. If you wish to change the monitor interval 
settings, click the button in the System column to display the list and select a 
monitor interval. When the number of channels is changed, the display in the 
Channel tab will be modified.

					   

Click here to enter the value
Click here to select from the list

Copy the settings of the first channel 
in the selected range to all other channels in the range
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Note
You can set multiple monitor intervals in the same system. If the same monitor interval is set for 
the MW100, it is assigned to each system in order from smallest measurement group number. 
Also, if the number of same monitor intervals is greater than the actual number of measurement 
groups, only the actual number of measurement groups is valid.

2.	 To display channel information, click the Channel tab.

	 You can also choose Channel from the View menu.

	

Click

Click the number to highlight the channel information
of the corresponding unit

Highest two digit: Registered unit number
Lowest three digit: Channel number (000 to 099), Math channel (more than 100)

Note
•	 The channel information is displayed only for channels that are set to acquire data in the 

MX100/MW100 settings.
•	 If the number of channels set in step 2 exceeds the actual number of channels that exists 

in the MX100/MW100, the portion of nonexistent channels is left blank. If the number of 
channels is less than the actual number of MX100/MW10 channels, only the set channels 
are displayed.

•	 If the connection fails, the channel information for the corresponding MX100/MW100 
appears as a blank line.

•	 If the channels of the modules installed to the MX100/MW100 do not match the channels 
displayed in the Channel tab, perform reconfiguration using the MX100 Standard Software 
or the Browser.

•	 The System No. from the channel information display is shown when information is retrieved 
or when setting the System column in the System Configuration screen.

•	 Click System No. to sort the channel information by system number.  Click System No. 
again to sort the channel information by channel number.

Click here to sort the 
channel information 
by system number

2.3  Retrieving Information about the Target MX100s/MW100s and Setting the Number of Channels and the Monitor Interval
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2.4 Starting/Stopping Data Monitoring

Before carrying out the procedure below, retrieve the channel information of the target 
MX100s in advance according to the instructions given in section 2.3, “Retrieving 
Information about the Target MX100s/MW100s.”

Procedure
Starting Data Monitoring
Click the Start Monitoring button or choose Start Monitoring from the Monitoring menu.

		

Click

Note
•	 If GateMX/MW is connected to the MX100, Backup mode will not be enabled when the 

communication is cut while monitoring data. Even if the /DS option is enabled, the Dual 
Save feature will not operate.

•	 If the initial communication with the target fails, retry ten seconds after the communication 
failure is confirmed. Additional time is required from the start of communication until the 
failure is recognized.

Displaying Run Status While Monitoring Data
Click the Run tab.
You can also choose Run from the View menu.

Click

Monitor interval specified on the MX100
The maximum and minimum channel numbers of the channel range assigned
to the same monitor interval.

The number of channels assigned to the same monitor interval

Number registered in the MX100 unit list under System.

Computer name of the PC running the
client software that is connected
(Maximum number of connections: 16)

Assigned system number

Acquisition Status
  Green: Normal (running)
  Red: Error (stopped, not able to connect, or there is no 
                      corresponding channel to monitor data.)
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Note
•	 The color of the unit numbers under Communication Status indicates the following 

conditions.
  Gray (characters in dark gray):	� There is no IP address or host name specified 

for the MX100/MW100 with that unit number 
(specification is blank). Or, there is an IP address 
or host name specified but the number of channels 
and system is not specified. 

  Green:			�   Communication with the MX100/MW100 is normal, 
and data is being monitored.

  Red:	 	 	 �There is an IP address or host name specified for 
the MX100/MW100 with that unit number, but the 
connection failed. Or, communication was cut while 
monitoring data, and now attempting to reconnect.

  Black:	 	 	 �There was an IP address or host name specified for the 
MX100 with the unit number and connection succeeded, 
but there were no channels set to acquire data.

	 If the icon is displayed in red, try the connection again.  If reconnection is successful, the 
icon turns green and acquisition resumes.  

	 When acquisition stops, all characters turn gray (characters in dark gray).  When acquisition 
resumes, registered items blink.  The gray color of unregistered items remains unchanged 
(characters in dark gray).  

					     blinks. does not change.↓ ↓

•	 The status of GateMX/MW is displayed in the status bar.  You can check the communication 
status displayed in the Run tab.  

Connection with MX100/MW100 normal

Connection with MX100/MW100 abnormal

Reconnecting with MX100s/MW100s 
(only displayed during communication) 

Number of connected clientsCondition status

•	 System numbers are assigned on the GateMX/MW System Configuration screen as shown 
in the figure below. Since four monitor intervals can be specified on each MX100/MW100, 
the system numbers are assigned in the range from 0 to 127.

	

MX100 of Unit No. 00

System No.1 2 3 4 5 6 7

100 ms 200 ms 500 ms 100 ms 200 ms 500 ms 1 sMonitor
interval

MX100 of Unit No. 01 MX100 of Unit No. 02

•	 Interval groups with the same monitor interval can be configured on the MX100 Standard 
Software (See the MX100 Standard Software User’s Manual (IM MX180-01E)).  A single 
interval group is displayed as a single system on GateMX/MW.

2.4  Starting/Stopping Data Monitoring
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1 s 100 ms

Settings on the MX100 Standard Software

Interval
group 1

Interval
group 2

1 s

Interval
group 3

100 ms

MX100

1 s

Displayed on GateMX/MW

System No. Unit No. Channel Range Interval Num. of Ch.
0
1

00
00

100 ms
1 s

•	 If a monitor interval longer than 1 minute is specified on the MX100 Standard Software, 
the monitor interval on the MX100 is set to 1 minute and the monitor interval longer than 1 
minute is achieved by decimating the data on the MX100 Standard Software.  Therefore, 
even if a monitor interval longer than 1 minute is specified on the MX100 Standard Software, 
the monitor interval is displayed as 1 minute on GateMX/MW, and the data is monitored at 
1-minute intervals.

1 s 100 ms

Settings on the MX100 Standard Software

Interval
group 1

Interval
group 2

1 hour

Interval
group 3

100 ms

MX100

1 s

Displayed on GateMX/MW

System No. Unit No. Channel Range Interval Num. of Ch.
0
1

00
00

100 ms
1 s

2 00 1 min

1 min

•	 If the interval group of different monitor intervals are set on the MX100 Standard Software, the 
MX100 sorts them by monitor intervals from fastest to slowest. Consequently, the GateMX/
MW also assigns system numbers in order from fastest to slowest monitor interval when 
retrieving the information on the System Configuration screen. If the system is set or changed 
on the System Configuration screen, the system numbers are assigned in the set order.

1 s 500 ms

Settings on the MX100 Standard Software

Interval
group 1

Interval
group 2

100 ms

Interval
group 3

100 ms

MX100

500 ms

Displayed on GateMX/MW

System No. Unit No. Channel Range Interval Num. of Ch.
0
1

00
00

100 ms
500 ms

2 00 1 s

1 s

Stopping Data Monitoring
Click the Stop Monitoring button or choose Stop Monitoring from the Monitoring menu.

		

Click

2.4  Starting/Stopping Data Monitoring
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2.5	 Connecting to GateMX/MW from DAQLOGGER,  
Remote Monitor, or Add-on Software

While data is being monitored by GateMX/MW, DAQLOGGER and remote monitors can 
log or monitor the MX100/MW100 data via the Ethernet network.  GateMX/MW operates 
as a monitor server for DAQLOGGER, remote monitor clients, and Add-on software.

Connecting to GateMX/MW from DAQLOGGER
See section 2.6 in the WX101 DAQLOGGER WX81 DAQLOGGER Client Package 
User’s Manual (IM WX101-01E).

Note
There are two methods to connect to GateMX/MW from DAQLOGGER.  One method is to 
specify the system number; the other is not to specify the system number.  For the procedure 
of selecting the connection method, see section 2.6 in the WX101 DAQLOGGER WX81 
DAQLOGGER Client Package User’s Manual (IM WX101-01E).
•	 Connecting to GateMX/MW by specifying the system number
	 Of the MX100s/MW100s connected to GateMX/MW, only the channel data with the specified 

system number is monitored.

DAQLOGGER

GateMX/MW

1 2 3 4 5 6 7

100 ms 200 ms 500 ms 100 ms 200 ms 500 ms 1 s

When monitoring data only from
the channels with system
numbers 3 and 5

3 5 System No.

MX100 of Unit No. 00

System No.

Monitor
interval

MX100 of Unit No. 01 MX100 of Unit No. 02

•	 Connecting to GateMX/MW without specifying the system number
	 The data of all the channels of the MX100s/MW100s connected to GateMX/MW is monitored 

using one connection.

DAQLOGGER

GateMX/MW

100 ms 200 ms 500 ms 100 ms 200 ms 500 ms 1 s

When monitoring data from
all the channels

1 2 3 4 5 6 7

MX100/MW100 of 
Unit No. 00

System No.

Monitor
interval

MX100/MW100 of 
Unit No. 01

MX100/MW100 of 
Unit No. 02

Connecting to GateMX/MW from the remote monitor
If you are connecting to GateMX/MW from the remote monitor of the DAQLOGGER 
Client Package, see section 8.1 in the WX101 DAQLOGGER WX81 DAQLOGGER 
Client Package User’s Manual (IM WX101-01E).
If you are connecting to GateMX/MW from the remote monitor of the DAQ32Plus Client 
Package, see section 9.2 in the WX102 DAQ32Plus WX82 DAQ32Plus Client Package 
User’s Manual (IM WX102-01E).

Connecting to GateMX/MW from the Add-on Software
If you are connecting to GateMX/MW from the Add-on software, see the user’s manual 
for the relevant product.
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2.6	 Changing the Port Number and Saving the 
Settings

Procedure
Changing the Port Number
Carry out the procedure below if you wish to change the TCP/IP port number that is used 
by DAQLOGGER or remote monitors to connect to GateMX/MW.

1.	 From the File menu, choose Port No..
	 The Port No. dialog box opens.

2.	 Enter the port number used for the monitor server.

	 The default value is 50297.

					   

3.	 Click OK and restart GateMX/MW.

	 You must restart GateMX/MW to activate the new port number.

Saving the Settings
From the File menu, choose Save or Save As.
If you choose Save As, enter the file name in the dialog box that appears and save the 
file.

		

Note
If you choose Save when you have not saved to a specific file name before, the same dialog 
box that opens as when you choose Save As opens.

Changing to the Saved Settings
From the File menu, choose Open.  Select and open the desired file in the dialog box 
that appears.
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2.7 Showing Version Information

Procedure
Click the About button on the toolbar or choose About from the Help menu.

		

Display version information

The About dialog box opens as shown below.

		

Version

Company name
User name
License number
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Chapter 3	 Error Messages and Corrective Actions

3.1 Error Messages and Corrective Actions

This section describes the messages and their corrective actions when errors occur.

Code Description Action
E0002 Insufficient memory.  Please exit 

immediately.
Close other software programs and restart GateMX/MW.  Or, restart 
Windows.

E0211 Cannot write to the file. Check whether there is sufficient space on the hard disk, whether writing is 
permitted, and whether the file system is operating normally.

E4800 The maximum limit of Gate 
programs running simultaneously 
has been exceeded.

The number of Gate programs that you can run simultaneously is limited by 
the Gate software license that you have purchased. Close a Gate program 
that is already running or purchase a new license and reinstall the program.
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